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kenmerken van uw nieuwe MP3-speler
Mooi. Intelligent. Betrouwbaar. En vooral leuk! Dat is uw nieuwe MP3-
speler, en nog veel meer. De ultramoderne technologie zorgt voor 
een krachtig geluid, heldere beelden en spelletjes met veel actie. U 
zult heel veel plezier beleven aan uw nieuwe MP3-speler, of u nu aan 
het sporten bent, uw favoriete nummers downloadt, video’s bekijkt, 
spelletjes speelt of gewoon naar de radio luistert. Nadat u hem eenmaal 
hebt gebruikt, vraagt u zich af hoe u ooit zonder hebt gekund.

MEER MULTI IN MULTIMEDIA
We noemen het een MP3-speler, maar het 
is veel meer dan dat. U kunt afbeeldingen, 
tekst en video’s bekijken, naar FM-radio 
luisteren en spelletjes spelen.

AANRAAKBEDIENING
Door licht op het aanraakvlak te tikken kunt 
u door de menu's bladeren.

LCD-KLEURENSCHERM
Op het LCD-scherm worden heldere kleuren 
en beelden weergegeven.

HET GEMAK VAN EEN EIGEN SELECTIE 
IN UW SPELER! 

U kunt een afspeellijst van uw favoriete 
muziek maken.

LANGERE AFSPEELDUUR EN KORTERE 
DOWNLOADTIJD
Met een volledig geladen batterij kan 
maximaal 30 uur muziek en 4 uur video 
worden afgespeeld.
Het downloaden gaat snel. Dankzij de 
compatibiliteit met USB 2.0 is de speler veel 
sneller dan modellen met USB 1.1.

WONDER VAN GELUIDSKWALITEIT
Uw nieuwe MP3-speler is uitgerust met 
DNSe™ (Digital Natural Sound-engine), 
de unieke geluidstechnologie van Samsung 
voor een rijker, dieper geluid en een 
ongelofelijke luisterbeleving.



veiligheidsinformatie
Betekenis van de pictogrammen en aanduidingen in 
deze gebruiksaanwijzing:

WAARSCHUWING

Risico van lichamelijk letsel met mogelijk fatale 
gevolgen.

LET OP
Risico van lichamelijk letsel of materiële schade.

LET OP

U kunt het risico op brand, ontploffi ng, elektrische 
schokken of lichamelijk letsel tijdens het gebruik van uw 
MP3-speler verminderen door de genoemde belangrijke 
voorzorgsmaatregelen in acht te nemen.

OPMERKING
Tips of verwijzingen naar informatie die u kunnen helpen 
bij het bedienen van de speler.

NIET proberen.

NIET demonteren.

NIET aanraken.

Volg de aanwijzingen nauwgezet op.

Haal de stekker uit het stopcontact.

Bel het servicecentrum voor assistentie.
Deze waarschuwingstekens dienen om persoonlijk letsel, van uzelf en van 
anderen, te voorkomen. Volg de aanwijzigen nauwgezet op.
Bewaar de gebruiksaanwijzing nadat u dit gedeelte hebt doorgelezen op 
een veilige plaats, zodat u deze informatie later nog eens kunt naslaan.



veiligheidsinformatie
In deze gebruiksaanwijzing wordt het juiste gebruik van uw nieuwe 
MP3-speler beschreven. Lees de gebruiksaanwijzing zorgvuldig door 
om te voorkomen dat u de speler beschadigt of uzelf verwondt.
Let met name op de volgende serieuze waarschuwingen:

BESCHERM UZELF
Demonteer, repareer of wijzig het product niet zelf.

Zorg dat het product niet nat wordt. Het product is niet waterbestendig. 
Als het product nat wordt, schakel het dan niet in. Anders zou u een 
elektrische schok kunnen krijgen. Neem in dat geval contact op met het 
dichtstbijzijnde Samsung Service Center.

Gebruik het product niet tijdens een onweer met bliksem. Anders loopt u 
het risico op storingen of elektrische schok.

Gebruik de oordopjes niet als u op een fi ets zit of een auto of motor 
bestuurt.
Dit kan een ernstig ongeluk veroorzaken. Het is bovendien in enkele landen bij wet 
verboden. Gebruik van de oortelefoon tijdens het lopen en joggen op de openbare 
weg, met name tijdens het oversteken, kan leiden tot ernstige ongelukken.

Let er tijdens het sporten of wandelen omwille van de veiligheid op dat 
de kabel van de oortelefoon niet achter uw arm of een object in uw 
omgeving kan blijven haken.

Plaats het product niet in een vochtige, stoffi ge of vuile omgeving. Anders 
zou brand kunnen ontstaan of loopt u het risico op een elektrische schok.

LET OP

WAARSCHUWING

LET OP



BESCHERM UZELF
Het gebruik van oortelefoon of hoofdtelefoon gedurende langere tijd kan 
leiden tot ernstige gehoorbeschadiging.
Blootstelling voor langere tijd aan een geluidsniveau van meer dan 85 dB kan 
uw gehoor schaden. Hoe hoger het geluidsniveau, des te ernstiger de mogelijke 
gehoorschade. (Een normaal gesprek vindt plaats op een niveau van 50 tot 60 dB. 
Het geluidsniveau op de weg is ongeveer 80 dB.) U wordt uitdrukkelijk aanbevolen 
het volumeniveau op medium te zetten. (Medium is doorgaans minder dan 2/3 van 
het maximum.)
Als u een piep in uw oren ervaart, moet u het volume verlagen of het 
gebruik van oortelefoon of hoofdtelefoon staken.

UW MP3-SPELER BESCHERMEN
Bewaar of gebruik de speler niet bij temperaturen boven 35°C 
(bijvoorbeeld een sauna of in een geparkeerde auto).
Zorg dat u de speler nergens tegen stoot en laat de speler niet vallen.
Plaats geen zware voorwerpen op de speler.
Voorkom dat externe deeltjes of stof in het product komen.
Plaats het product niet in de buurt van magnetische objecten.
Zorg dat u een reservekopie van belangrijke gegevens maakt. Samsung 
is niet aansprakelijk voor verlies van gegevens.
Gebruik uitsluitend door Samsung geleverde of goedgekeurde accessoires.
Spuit geen water op het product. Maak het product niet schoon met 
chemicaliën als benzeen of thinner. Hierdoor kan er brand ontstaan, kunt 
u een elektrische schok krijgen en kan het oppervlak beschadigd raken.
Het niet opvolgen van deze instructies kan tot lichamelijk letsel leiden of 
schade aan de speler veroorzaken.
Als u deze gebruiksaanwijzing wilt afdrukken, adviseren we u dat u deze 
in kleur afdrukt en de optie “Aan pagina aanpassen” in de afdrukopties 
selecteert voor een betere weergave.

LET OP

OPMERKING

WAARSCHUWING

LET OP



inhoud
BASISINFORMATIE

10
10 Inhoud van de verpakking
11 Uw MP3-speler
14 Schermen
17 Werken met het aanraakvlak
18 De batterij opladen
19 Onderhoud van de batterij
19 De speler in- en uitschakelen
20 Muziek afspelen
20 Het volume regelen
21 De toetsen vergrendelen
21 Bestanden zoeken met “File browser” 

(Bestandsbrowser)
22 Bestanden verwijderen met “File 

browser” (Bestandsbrowser)
23 Instellingen en voorkeuren wijzigen
23 Instellingen voor menustijl
24 Geluidsinstellingen
25 Weergave-instellingen
26 Taalinstellingen
27 Datum en tijd instellen
28 Systeeminstellingen
32 De MP3-speler resetten

EMODIO

33
33 Systeemvereisten
34  EmoDio installeren
35 EmoDio gebruiken



inhoud
MUZIEK

BELUISTEREN

36
36 Luisteren op categorie
38 Pauzeren
38 Zoeken binnen een nummer
38 Afspelen vanaf het begin van het 

huidige nummer
38 Het vorige nummer afspelen
38 Het volgende nummer afspelen
39 Een afspeellijst op uw mp3-speler 

maken
40 Een afspeellijst afspelen
41 Een bestand verwijderen uit de 

afspeellijst
41 Alle bestanden verwijderen uit de 

afspeellijst
42 Het muziekmenu gebruiken

EEN VIDEO BEKIJKEN

54
54 Een video bekijken
54 Pauzeren
55 Naar een specifi ek frame gaan
55 Het vorige videobestand afspelen
55 Het volgende videobestand afspelen
56 Het videomenu gebruiken



inhoud
AFBEELDINGEN

BEKIJKEN

58
58 Afbeeldingen bekijken
59 Het afbeeldingsmenu gebruiken

NAAR DE FM-RADIO 
LUISTERE

71
71 Naar de FM-radio 

luistere
71 De dempfunctie gebruiken
72 FM-stations zoeken
73 Het menu FM-radio gebruiken

DATACASTS WEERGEVEN

80
80 Datacasts weergeven

TEKST LEZEN

64
64 Tekst lezen
65 Het tekstmenu gebruiken



BIJLAGE

89
89 Overzicht van menuopties
90 Productspecifi caties
92 Licentie

inhoud

PROBLEMEN
OPLOSSEN

86
86  Problemen oplossen

DE EXTRA FUNCTIES 
GEBRUIKEN

81
81 Stemopname
83 Videogames spelen
85 Wereldkaart metro weergeven



10 _ basisinformatie

basisinformatie
INHOUD VAN DE VERPAKKING
Bij uw nieuwe MP3-speler worden de volgende accessoires geleverd. Als een 
van deze items ontbreekt, moet u contact opnemen met de klantenservice van 
Samsung.

Speler Oortelefoon

USB-kabel Installatie-cd

Het ontwerp van de accessoires kan ter verbetering van het product zonder 
voorafgaande kennisgeving worden gewijzigd.
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UW MP3-SPELER

Scherm

Toets Aan/uit en Vergrendelen

Naar de onderzijde van de speler 
schuiven en vergrendelen om de speler 
aan of uit te zetten.
Naar de bovenzijde van de speler 
schuiven om de functietoetsen te 
vergrendelen.

Resetopening
Als er een storing in de speler 
optreedt, drukt u met een puntig 
voorwerp in de resetopening om het 
systeem opnieuw te initialiseren.

Microfoon
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UW MP3-SPELER (Vervolg)
Dit zijn tiptoetsen.

Toets Vorige
Hierop tikken om naar het vorige scherm 

te gaan. Iets langer indrukken om naar het 
scherm met het hoofdmenu te gaan.

Toets Volume omhoog
Hierop tikken om het volume te verhogen of om 

naar een bovenliggend item of menu te gaan.

Toets Afspelen/Onderbreken/Selecteren
Hierop tikken om afspelen/onderbreken en 

functie te selecteren, naar het volgende scherm 
gaan

Linkertoets bestandsbrowser
Hierop tikken om naar het vorige nummer of 
menu te gaan of het huidige nummer vanaf 
het begin af te spelen Iets langer indrukken 

om snel langs de nummers te lopen.

Toets Volume omlaag
Hierop tikken om het volume te verlagen of om 

naar een onderliggend item of menu te gaan.

Rechtertoets bestandsbrowser
Hierop tikken om naar het volgende nummer of 

menu te gaan. Iets langer indrukken om snel 
langs de nummers te lopen.

Toets Menu
Hierop tikken om het menu weer te geven
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UW MP3-SPELER (Vervolg)

Oortelefoon
Op het linkerdopje ziet u een “L” en 

op het rechterdopje een “R”. Fungeert 
tevens als antenne voor de FM-radio 

in de MP3-speler.
Als u tijdens het afspelen van muziek 

de koptelefoon loskoppelt, zal de 
muziek worden gepauzeerd.

Oortelefoonstekker

USB-aansluiting

Bevestiging nekkoord
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Music

 Rising Sun
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SCHERMEN
Muziek

1 Indicator hoofdmenu

2 Vergrendelindicator

3 Batterijstatus

4
Indicator huidig nummer / 
totaal aantal nummers

5 Afspeelsnelheid

6 Huidige tijd

7 Totale afspeeltijd

8 Afspelen/pauzeren/zoeken

9 Indicator muziekmodus

10 Indicator afspeelmodus

11 Indicator DNSe-modus

12 Muziekafspeelscherm

13 Titel

14 Statusbalk afspelen

15 Huidige afspeeltijd

De schermafbeeldingen dienen slechts ter illustratie. Het scherm kan er in 
werkelijkheid anders uitzien.
Alle andere informatie met uitzondering van het muziekafspeelscherm zal snel 
verdwijnen. Tik op een willekeurige knop om de informatie opnieuw weer te geven.

OPMERKING
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SCHERMEN (Vervolg)
Video

1 Vergrendelindicator

2 Batterijstatus

3 Huidige tijd

4 Totale afspeeltijd

5 Afspelen/pauzeren/zoeken

6 Indicator videomodus

7 Bestandsnaam

8 Statusbalk afspelen

9 Huidige afspeeltijd
Afbeelding

1 Vergrendelindicator

2 Batterijstatus

3
Indicator huidig bestand / 
totaal aantal bestanden

4 Huidige tijd

5 Afspeelstatus muziek

6 Indicator Afbeeldingsmodus

7 Indicator hoofdmenu

8 Bestandsnaam

Video Track 1
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8
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SCHERMEN (VERVOLG)
FM-radio

1 Huidige tijd

2 Batterijstatus

3 Vergrendelindicator

4 Indicator radiomodus

5 Handmatig/voorkeuze

6 Huidige frequentie (MHz)

7 Frequentielocatie

8 RDS-indicator

Wat is RDS?
RDS (Radio Data System (Radiogegevenssysteem)) verzorgt de ontvangst en 
weergave van berichten zoals uitzendinformatie. 
De programmagegevens zoals News (Nieuws), Sports (Sport) of Music (Muziek), of 
informatie over het zendstation worden weergegeven op het display.
Als het FM-signaal zwak is, worden de RDS-gegevens mogelijk niet weergegeven.

OPMERKING

1

Manual

3

4

6

7

2

5

News
 Today Headline

8
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WERKEN MET HET AANRAAKVLAK
Tik met uw vingertop op het aanraakvlak.

Gebruik alleen uw vingers voor de bediening van het apparaat. Om schade te 
voorkomen dient u geen andere objecten te gebruiken voor de bediening.
Tik niet op het aanraakvlak met vuile vingers.
Tik niet op het aanraakvlak met handschoenen aan.
Het aanraakvlak werkt mogelijk niet goed als u bijvoorbeeld uw vingernagel of een 
balpen gebruikt.

OPMERKING
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DE BATTERIJ OPLADEN
Laad de speler op voordat u deze voor het eerst gebruikt en wanneer u deze 
lange tijd niet hebt gebruikt.
Het volledig opladen van de batterij van uw MP3-speler duurt ongeveer 3 uur. 
De totale oplaadtijd kan echter variëren, afhankelijk van uw computeromgeving.

1. Sluit het grootste uiteinde van de USB-kabel aan op de USB-aansluiting aan 
de onderkant van de speler.

2. Sluit de USB-kabel aan op de USB-poort ( ) van de computer.

2

Schermweergave
<USB connected>
(Verbonden via USB)
< > - Opladen
< > - Volledig opgeladen

1
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ONDERHOUD VAN DE BATTERIJ
De batterij gaat langer mee als u de volgende eenvoudige richtlijnen voor het 
onderhouden en opbergen van de speler in acht neemt.
• Laad de batterij op bij een temperatuur tussen 5°C~35°C (40°F~95°F).
• De batterij niet te lang opladen (niet langer 12 uur). 

Overmatig opladen of ontladen kan de levensduur van de batterij verkorten.
• Aangezien een batterij een verbruiksartikel is, neemt de levensduur van de 

batterij na verloop van tijd geleidelijk af.

Als u de speler oplaadt door deze aan te sluiten op een draagbare computer, 
controleer dan eerst of de batterij van de draagbare computer zelf volledig is 
opgeladen of de draagbare computer is aangesloten op het lichtnet.
De oplaadbare batterij in dit product kan niet door de gebruiker zelf worden 
vervangen. Neem contact op met uw serviceprovider voor informatie over vervanging.

DE SPELER IN- EN UITSCHAKELEN
De speler inschakelen
Schuif en vergrendel de schakelaar [ ] naar de 
onderzijde van de speler.

De speler wordt ingeschakeld.
De speler uitschakelen
Schuif en vergrendel de schakelaar [ ] nogmaals 
naar de onderzijde van de speler.

De speler wordt uitgeschakeld.
Het toestel wordt automatisch uitgeschakeld als gedurende een bepaalde tijd geen 
toetsen worden ingedrukt in de stopstand. De fabrieksinstelling voor <Auto Power 
Off> (Autom. uitschakelen) is 1 minuut, maar u kunt deze tijd zelf wijzigen. Zie 
pagina 29 voor meer informatie.

OPMERKING

OPMERKING

LET OP
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MUZIEK AFSPELEN
Zet eerst met behulp van EmoDio muziekbestanden op uw nieuwe MP3-speler.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts]

om <Music> (Muziek) te selecteren en tik op de toets
[Selecteren].

3. Gebruik de toetsen [Omhoog, Omlaag] en de toets
[Selecteren] om het gewenste muziekbestand te 
selecteren.

4. Tik op de toets [Selecteren] om het geselecteerde muziekbestand af te 
spelen.

Het muziekbestand wordt afgespeeld.
Tik op [ ] om naar het vorige scherm te gaan. 
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

HET VOLUME REGELEN
Tik op de toets [Omhoog, Omlaag].

Er wordt een volumesymbool weergegeven.
Het volumebereik is ingesteld van 0 tot 30.
Tik op de toets [Omhoog] om het volume te verhogen en tik op de 
toets [Omlaag] om het volume te verlagen.

OPMERKING

Music

Rising Sun

02:13 04:28

Music

Rising Sun

02:13 04:28
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DE TOETSEN VERGRENDELEN
Met de vergrendelfunctie kunt u alle andere toetsen op de MP3-speler 
deactiveren, zodat uw muziek niet wordt onderbroken wanneer een van de 
toetsen, bijvoorbeeld tijdens het sporten, per ongeluk wordt ingedrukt.
1. Schuif de schakelaar [ ] naar de bovenzijde 

van de speler om de vergrendelfunctie in te schakelen.
2. Schuif de schakelaar [ ] naar de onderzijde 

van de speler om de vergrendelfunctie uit te schakelen.

BESTANDEN ZOEKEN MET “FILE BROWSER”
(BESTANDSBROWSER) 
U kunt eenvoudig bestanden zoeken met de functie “File Browser” (Bestandsbrowser).
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<File Browser> (Bestandsbrowser) te selecteren en tik op 
de toets [Selecteren].

De map <File Browser> (Bestandsbrowser) wordt weergegeven. Deze 
bevat Music (muziek), Playlists (afspeellijsten), Video (video), Pictures 
(afbeeldingen), Datacasts, Texts (teksten), Games (spelletjes), Recorded 
Files (opgenomen bestanden) en My Pack (Mijn pakket).

3. Tik op de toets [Omhoog, Omlaag] om de gewenste map 
te selecteren.

4. Tik op de toets [Selecteren] om de lijst met 
bestanden in de geselecteerde map weer te geven.

Tik op [ ] om naar het vorige scherm te gaan.
5. Tik op de toets [Omhoog, Omlaag] om het gewenste bestand te selecteren.
6. Tik op de toets [Selecteren].

Het bestand wordt afgespeeld.

Music

Rising Sun

02:13 04:28
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BESTANDEN VERWIJDEREN MET “FILE BROWSER” 
(BESTANDSBROWSER)
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<File Browser> (Bestandsbrowser) te selecteren en tik op 
de toets [Selecteren].

De mappenlijst <File Browser> (Bestandsbrowser) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste map 
te selecteren en tik op de toets [Selecteren].

4. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren dat u wilt 
verwijderen, en tik op [ ].

5. Tik op de toets [Omhoog, Omlaag] om <Delete> (Verwijderen) te selecteren 
en tik op de toets [Selecteren].

Het bevestigingsvenster wordt weergegeven.

6.  Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik op de 
toets [Selecteren].

Het bestand wordt verwijderd.

Bestanden kunnen niet meer worden hersteld nadat ze zijn verwijderd.

Het bestand dat op dat moment wordt afgepeeld, wordt niet verwijderd.
De map <My Pack> (Mijn pakket) in de map <File Browser> (Bestandsbrowser) 
bevat DNSe-bestanden die zijn overgebracht via <EmoDio>. Zie <EmoDio> voor 
meer informatie over DNSe.

OPMERKING

LET OP

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
My Pack
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INSTELLINGEN EN VOORKEUREN WIJZIGEN
De instellingen en voorkeuren van de MP3-speler zijn in de fabriek ingesteld, 
maar u kunt deze voorgeprogrammeerde waarden zelf aan uw persoonlijke 
voorkeuren aanpassen.

Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

Instellingen voor menustijl
U kunt het uiterlijk van het menu wijzigen en de achtergrondafbeelding 
van het hoofdmenu verwijderen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te selecteren 
en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om <Menu

Style> (Menustijl) te selecteren en tik op de toets
[Selecteren].

Het menu <Menu Style> (Menustijl) wordt weergegeven.
4. Gebruik de toetsen [Omhoog, Omlaag] en [Selecteren] om de 

functies in te stellen.
Druk op de toets [Selecteren] om naar het volgende item te gaan of het 
menu te selecteren.
Tik op de toets [Omhoog, Omlaag] om in het huidige menu te bladeren.

Instellingsopties voor menustijl
Menu Design (Menuontwerp) : U kunt de stijl van het hoofdmenu wijzigen. Maak 
een keuze uit <Matrix> en <My Skin> (Mijn Skin).
Font (Lettertype) : U kunt het lettertype van de menutaal wijzigen. Kies één van de 
drie lettertypes. Voor sommige talen is de optie <Font> (Lettertype) uitgeschakeld.
Reset My Skin (Mijn Skin opnieuw instellen) : Stelt de achtergrondafbeelding van 
het aanraakscherm in op de standaardafbeelding. 

OPMERKING

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Geluidsinstellingen
U kunt de hoofd-EQ, de pieptoon en de volumegrens instellen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te selecteren 
en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om 

<Sound> (Geluid) te selecteren en tik op de toets
[Selecteren].

Het menu <Sound> (Geluid) wordt weergegeven.
4. Gebruik de toetsen [Omhoog, Omlaag] en [Selecteren] om de 

functies in te stellen.

Opties voor geluidsinstellingen
Master EQ (Hoofd-EQ) : U kunt de geluidsinstellingen optimaliseren. 
Tik op de toets [Links, Rechts] om de frequentie te selecteren die u wilt 
aanpassen. Tik op de toets [Omhoog, Omlaag] om het niveau van de 
geselecteerde frequentie aan te passen en tik op de toets [Selecteren].
Beep Sound (Piepgeluid) : Het geluidssignaal voor de bediening van het 
aanraakscherm inschakelen of uitschakelen. U kunt kiezen tussen <Off> (UIT) 
en <On> (AAN).
Volume Limit (Volume grens): U kunt gehoorbeschadiging bij gebruik van de 
koptelefoon voorkomen door een volumegrens in te stellen. Als de volumegrens 
is ingeschakeld, is het maximumvolume 15. 
Als de volumegrens is uitgeschakeld, is het maximumvolume 30.
Als u <Off> (UIT) selecteert, wordt het volume teruggezet naar 15 om schade 
aan uw gehoor te voorkomen wanneer u de speler weer inschakelt.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Weergave-instellingen
De uitschakeltijd en helderheid van uw scherm wijzigen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te 
selecteren en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<Display> (Beeld) te selecteren en tik op de toets
[Selecteren].

Het menu <Display> (Weergave) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [Selecteren] om de 
functies in te stellen.

Opties voor weergave-instellingen
Display Off (Display Uit) : Als geen wachttijd is ingesteld, wordt het scherm 
automatisch uitgeschakeld. U kunt kiezen uit <15sec>, <30sec>, <1min>, 
<3min>, <5min> en <Always On> (Altijd aan). U kunt het scherm weer 
inschakelen door op een willekeurige toets te drukken.
Brightness (Helderheid) : U kunt de helderheid van het scherm instellen.Kies 
een niveau van <0-10>, met 10 als meest helder.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Taalinstellingen
De menu’s van de MP3-speler kunnen worden ingesteld om in diverse talen 
te worden weergegeven. U kunt uw voorkeurstaal eenvoudig instellen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te 
selecteren en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<Language> (Taal) te selecteren en tik op de 
toets [Selecteren].

De lijst <Language> (Taal) wordt weergegeven.

<English>, <한국어>, <Français>, <Deutsch>, <Italiano>, <日本語>,
< >, < >, <Español>, < >, <Magyar>, <Nederlands>, 
<Polski>, <Português>, <Svenska>, < >, < eština>, < >,
<Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español (Sudamérica)>, 
<Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, <Român >,
< >, <Slovenš ina>, <Slovenský>.

4. Tik op de toets [Omhoog, Omlaag] om de gewenste taal te 
selecteren en tik op de toets [Selecteren].

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Datum en tijd instellen
De huidige datum en tijd instellen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te 
selecteren en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om
<Date&Time> (Datum en tijd) te selecteren en tik 
op de toets [Selecteren].

Het scherm Time Set (Tijd instellen) wordt weergegeven.

4. Tik op de toets [Links, Rechts] om naar <YEAR, MONTH, DATE, 
HOUR, MIN, AM/PM> (Jaar, Maand, Dag, Uur, Minuut, AM/PM) te 
gaan en tik vervolgens op de toets [Omhoog, Omlaag] om elk item in 
te stellen.

5. Tik op de toets [Selecteren].
Het opslagbevestigingsvenster wordt weergegeven.

6. Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik 
op de toets [Selecteren].

De datum/tijd-instelling wordt opgeslagen.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Systeeminstellingen
Kies de instellingen voor de sluimerfunctie en automatisch uitschakelen 
die bij u passen.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, 

Rechts] om <Settings> (Instellingen) te 
selecteren en tik op de toets [Selecteren].

Het menu <Settings> (Instellingen) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<System> (Systeem) te selecteren en tik op de 
toets [Selecteren].

Het menu <System> (Systeem) wordt weergegeven.

4. Gebruik de toetsen [Omhoog, Omlaag] en [Selecteren] om de 
functies in te stellen.

Settings

Menu Style
Sound
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Date&Time 
System
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Opties voor systeeminstellingen

My Profi le (Mijn profi el) : U kunt uw naam en geboortedatum instellen. Zie pagina 30~31.
Sleep (Standby) : Het apparaat wordt na de opgegeven tijd automatisch uitgeschakeld. U 
kunt kiezen uit <Off> (UIT), <15 min >, <30min>, <60min>, <90min> en <120min>.
Start Mode (Startmodus) : U kunt instellen dat het startscherm wordt weergegeven als u 
de speler inschakelt. U kunt kiezen uit <Main Menu> (Hoofdmenu) en <Last State> (Vorige 
status). Kies <Main Menu> (Hoofdmenu) om het systeem op te starten in het hoofdmenu of 
<Last State> (Vorige status) om op te starten in het laatst gebruikte menuscherm.
Auto Power Off (Autom. Uitschakelen) : Schakelt de stroom automatisch uit als de eenheid 
in de modus Pause (Pauze) staat en de toetsen niet worden geactiveerd binnen de vooraf 
ingestelde tijd. U kunt kiezen uit <15sec>, <30sec>, <1min>, <3min>, <5min> of <Always On> 
(Altijd aan).
Default Set (Standaard instellen) : De standaardwaarden voor alle instellingen 
worden hersteld. U kunt kiezen uit <Yes> (Ja) en <No> (Nee). Met <Yes> (Ja) zet u alle 
instellingen terug naar de beginwaarden. Met <No> (Nee) annuleert u het herstellen van de 
standaardinstellingen.
Format (Formatteren) : Het interne geheugen formatteren. U kunt kiezen uit <Yes> (Ja) en 
<No> (Nee). Als u <Yes> (Ja) kiest, wordt het interne geheugen geformatteerd en worden alle 
bestanden op de speler gewist. Als u <No> (Nee) selecteert, wordt het interne geheugen niet 
geformatteerd. Controleer voordat u gaat formatteren of alle bestanden gewist mogen worden.
About (Info) : Tik op de toets [Links, Rechts] om de versie van de fi rmware, de 
geheugencapaciteit en het nummer van het bestand te controleren. Met <Firmware 
Version> (Firmwareversie) wordt de huidige versie van de fi rmware weergegeven. 
<Memory> (Geheugen) - <Used> (Gebruikt) geeft het gebruikte geheugen aan, <Available> 
(Besch.) geeft het resterende geheugen aan en <Total> (Totaal) staat voor de totale 
geheugencapaciteit. <Files> (Bestanden) - U kunt het aantal muziekbestanden, video’s, foto’s, 
tekst en hele bestanden selecteren.
Demo mode (Demomodus) : Als u de demomodus instelt op <On> (Aan), wordt de clip in de 
videomap herhaald. Om terug te keren naar het vorige scherm, tikt u op het aanraakvlak.

Het ingebouwde geheugen
1GB=1.000.000.000 bytes : de werkelijke, geformatteerde capaciteit is 
mogelijk minder omdat een gedeelte van het geheugen wordt gebruikt door 
de interne fi rmware.

OPMERKING
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Mijn naaminstellingen

1. Tik op de toets [Omhoog, Omlaag] om <My
Profi le> (Mijn profi el) te selecteren en tik op de 
toets [Selecteren].

2. Tik op de toets [Omhoog, Omlaag] om <My
Name> (Mijn naam) te selecteren en tik op de toets
[Selecteren].

Het venster Mijn naam wijzigen wordt weergegeven.

3. Gebruik de toetsen [Omhoog, Omlaag, Links, 
Rechts] en [Selecteren] om de naam van het apparaat te wijzigen.

[  ] : De invoermodus schakelt over van Engels met hoofdletters naar 
Engels met kleine letters en naar cijfers.

[  ] : U kunt de tekens één voor één wissen.
[  ] : U kunt het volgende invoegen: ‘–‘.
[  ] : Hiermee bevestigt u de wijziging.
Als u de naam hebt ingesteld, ziet u uw naam als u de speler inschakelt.

Rename My ..

_
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INSTELLINGEN EN VOORKEUREN WIJZIGEN (Vervolg)
Mijn verjaardagsinstellingen

Voordat u begint! - Eerst moet u de klok op de huidige tijd instellen. 
Zie pagina 27.

1. Tik op de toets [Omhoog, Omlaag] om 
<My Profi le> (Mijn profi el) te selecteren en tik op de 
toets [Selecteren].

2. Tik op de toets [Omhoog, Omlaag] om
 <My Birthday> (Mijn verjaardag) te selecteren en 
tik op de toets [Selecteren].

Het venster <Edit My Birthday> (Mijn verjaardag 
wijzigen) wordt weergegeven.

3. Tik op de toets [Links, Rechts] om naar 
<YEAR, MONTH, DATE> (Jaar, Maand en Datum) te gaan en tik 
vervolgens op de toets [Omhoog, Omlaag] om elk item in te stellen.

4. Tik op de toets [Selecteren].
Als u de verjaardagsinstellingen hebt voltooid, wordt u aan uw verjaardag 
herinnerd als u de speler inschakelt.

Edit My Birth..
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DE MP3-SPELER RESETTEN
Als uw MP3-speler niet start, geen muziek wil afspelen of niet wordt herkend 
door uw computer wanneer u deze aansluit, is het misschien nodig het systeem 
te resetten.

Druk niet met een puntig voorwerp in de opening van de microfoon, omdat dit het 
product kan beschadigen.LET OP

Druk met een puntig voorwerp, zoals een 
veiligheidsspeld, aan de onderzijde van het 
product de Resetopening in.

Het systeem wordt geïnitialiseerd.
Met de Reset-functie worden geen 
tijdgegevens en gegevens in het ingebouwde 
geheugen verwijderd.
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EmoDio
EmoDio is een softwaretoepassing voor deze MP3-speler met 
diverse contentgerelateerde services en ondersteuning van 
apparaten.

SYSTEEMVEREISTEN
Uw computersysteem moet minimaal voldoen aan de volgende specifi caties om 
EmoDio te installeren en gebruiken:
• Pentium 500MHz of hoger
• USB 2.0-poort
• Windows XP Service Pack 2 of 

hoger
• DirectX 9.0 of hoger
• 100 MB vrije schijfruimte

• Cd-romstation (2x of hoger)
• Windows Media Player 10.0 of 

hoger
• Resolutie 1024 X 768 of hoger
• Internet Explorer 6.0 of hoger
• 512 MB RAM of hoger

Koppel de USB-kabel niet los tijdens de bestandsoverdracht. Loskoppelen van 
de USB-connector tijdens bestandsoverdracht kan leiden tot beschadiging van de 
speler en de computer.
Sluit de speler rechtstreeks op de computer aan in plaats van via een USB-hub. 
Zo voorkomt u een instabiele verbinding.
Zolang de speler is aangesloten op de computer, zijn alle functies uitgeschakeld.
Gebruik FAT 32 voor het bestandssysteem wanneer u de speler op uw computer 
formatteert.Klik in Windows Vista op Standaardwaarde voor apparaat herstellen en 
begin met het formatteren.

LET OP

OPMERKING
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EMODIO INSTALLEREN
Voer het installatieprogramma van <EmoDio> uit via de beheerdersaccount op uw 
computer. Anders wordt <EmoDio> niet geïnstalleerd. Meer informatie over het 
gebruik van de beheerdersaccount vindt u in de handleiding van uw computer.

1. Plaats de installatie-cd die bij de speler is 
geleverd in het cd-romstation.

2. Klik op <Install now> (Nu installeren).
Volg de instructies om de installatie te starten
De installatie van <EmoDio> wordt gestart. 
Wanneer de installatie is voltooid, verschijnt het 
pictogram  op uw bureaublad.

Wees voorzichtig bij het plaatsen en uitnemen van de installatie-cd als uw cd-rom-
station verticaal is geïnstalleerd.

De technologie voor het herkennen van muziek en verwante gegevens wordt 
geleverd door Gracenote en Gracenote CDDB® Music Recognition ServiceSM.
CDDB is een gedeponeerd handelsmerk van Gracenote. Het logotype en logo 
van Gracenote, Gracenote CDDB en het logo “Powered by Gracenote CDDB” zijn 
gedeponeerde handelsmerken van Gracenote. Music Recognition Service en MRS 
zijn servicemerken van Gracenote.

OPMERKING

LET OP

LET OP
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EMODIO GEBRUIKEN
EmoDio is een gebruiksvriendelijke softwaretoepassing voor het ordenen van 
bestanden op uw computer. Nadat uw bestanden zijn geordend in EmoDio, kunt 
u de bestanden in een handomdraai overzetten naar uw MP3-speler, zonder dat 
u de hele vaste schijf hoeft te doorzoeken voor het juiste bestand.

 “EmoDio” biedt de handigste manier om uw bestanden van uw 
computer over te zetten naar uw MP3-speler.

Met “EmoDio” kunt u uw eigen collectie of album van 
geluidsbestanden samenstellen.

U kunt RSS-bloginformatie en -bestanden naar de speler 
overbrengen voor uw plezier.

Dit is een online gemeenschapsservice voor EmoDio.com-
gebruikers. Inhoud aangemaakt via EmoDio kan eenvoudig worden 
ge-upload / gedownload en deze service biedt manieren om uw 
verhalen met andere gebruikers in de gemeenschap te delen. 

Voor meer informatie over <EmoDio> klikt u op <MENU>  <Help> <Help>
boven in het programma <EmoDio>.OPMERKING
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muziek beluisteren
Voordat u begint! -  De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

LUISTEREN OP CATEGORIE

1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om <Music> (Muziek) te 

selecteren en tik op de toets [Selecteren].
De lijst <Music> (Muziek) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste lijst te selecteren en tik 
op de toets [Selecteren].

Het muziekbestand wordt weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren dat u wilt 
afspelen en tik op de toets [Selecteren].

De muziek wordt afgespeeld.

OPMERKING

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser
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LUISTEREN OP CATEGORIE (VERVOLG)
Muzieklijst
Bestandsinformatie, waaronder naam van de artiest, naam van het album, titel van het 
nummer en het genre worden weergegeven, gebaseerd op de ID3-taginformatie bij 
het muziekbestand. Bestanden zonder ID3-Tag worden weergegeven als <Unknown> 
(Onbekend).

Now Playing (Nu Speelt) : Speelt een recent afgespeeld bestand of gaat naar het 
afspeelscherm van het huidige bestand.
Artists (Artiest) : Afspelen op artiest
Albums (Album) : Afspelen op album. Tik op [ ] om een <List Type> (Lijsttype) te 
selecteren. Selecteer <Album Art> (Albumontw.) om zowel de afbeelding van de hoes als 
de titel van het album gelijktijdig te bekijken of selecteer <List> (Lijst) om alleen de titel van 
het album te bekijken.
Songs (Nummers) : Afspelen in numerieke of alfabetische volgorde
Genres (Genre) : Afspelen op genre 
Playlists : Afspelen op afspeellijst
Recorded Files (Opgenomen Bestanden) : Toont alle opgenomen bestanden.
Music Browser (Muziekbrowser) : Geeft alle muziekbestanden in de muziekmap weer.

De speler kan MP3- en WMA-muziekbestanden afspelen.
MP1- of MP2-bestanden waarvan alleen de extensie is gewijzigd in MP3, kunnen 
niet worden afgespeeld op de speler.
Als u tijdens het afspelen van muziek de koptelefoon loskoppelt, zal de muziek 
worden gepauzeerd.
Wat is een ID3-taginformatie?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals de 
titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen. 

OPMERKING
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PAUZEREN
1. Tik op de toets [Selecteren] terwijl de muziek wordt afgespeeld.

Het afspelen van de muziek wordt onderbroken.

2. Tik nogmaals op de toets [Selecteren].
De muziek wordt afgespeeld vanaf het punt waar het afspelen is gestopt.

ZOEKEN BINNEN EEN NUMMER
1. Houd de toets [Links, Rechts] ingedrukt terwijl het geselecteerde nummer 

wordt afgespeeld.
Er wordt gezocht richting het begin of het einde van het nummer.

2. Laat de toets los op het punt waar u wilt starten.
Het nummer wordt afgespeeld vanaf het moment dat u de toets loslaat.

AFSPELEN VANAF HET BEGIN VAN HET HUIDIGE NUMMER
Tik na 3 seconden afspelen op de toets [Links].

Het huidige nummer wordt afgespeeld vanaf het begin.

HET VORIGE NUMMER AFSPELEN
Tik binnen 3 seconden afspelen op de toets [Links].
Tik na 3 seconden afspelen tweemaal op de toets [Links].

Het vorige nummer wordt afgespeeld.
Wanneer u VBR-bestanden (Variable Bit Rate) afspeelt, wordt het vorige nummer 
mogelijk niet afgespeeld, ook al tikt u binnen 3 seconden op de toets [Links].

HET VOLGENDE NUMMER AFSPELEN
Tik op de toets [Rechts].

Het volgende nummer wordt afgespeeld.

LET OP
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EEN AFSPEELLIJST OP UW MP3-SPELER MAKEN
Als u al bestanden hebt gedownload naar uw MP3-speler, kunt u een afspeellijst 
met ‘Favorieten’ samenstellen.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om
<File Browser> (Bestandsbrowser) te selecteren en tik op 
de toets [Selecteren].

3. Tik op de toets [Omhoog, Omlaag] om <Music> (Muziek) 
te selecteren en tik op de toets [Selecteren].

De muziekbestanden worden weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren dat u aan 
de afspeellijst wilt toevoegen, en tik op [ ].

Het menu Afspeellijst wordt weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om <Add to Playlist> (Toev. aan afsp.) te 
selecteren en tik op de toets [Selecteren].

<Playlist 1>(Afspeellijst 1) tot en met <Playlist 5>(Afspeellijst 5) wordt weergegeven.

6. Tik op de toets [Omhoog, Omlaag] om het nummer van de afspeellijst te 
selecteren waaraan u het geselecteerde bestand wilt toevoegen en tik op de 
toets [Selecteren].

Het geselecteerde bestand wordt aan de afspeellijst toegevoegd. 
U kunt de afspeellijst bekijken via <Music>(Muziek)  <Playlists>  <Playlist 
1>(Afspeellijst 1) tot en met <Playlist 5> (Afspeellijst 5) in het hoofdmenu.

U kunt maximaal 100 muziekbestanden toevoegen aan elke afspeellijst (Playlist 1 
<Afspeellijst 1> tot en met Playlist 5 <Afspeellijst 5>).
Raadpleeg <EmoDio> voor informatie over het aanmaken van een afspeellijst in 
<EmoDio> en het overdragen van deze lijst naar de speler.

OPMERKING
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EEN AFSPEELLIJST AFSPELEN
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts]

om <Music> (Muziek) te selecteren en tik op de toets
[Selecteren].

De lijst <Music> (Muziek) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Playlists>
(Afspeellijsten) te selecteren en tik op de toets
[Selecteren].

De afspeellijsten worden weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om de gewenste afspeellijst te 
selecteren en tik op de toets [Selecteren].

De muziekbestanden die in de geselecteerde afspeellijst zijn opgeslagen, worden 
weergegeven.
Als geen afspeellijst wordt gevonden, wordt de melding 
<No File> (Geen bestanden.) op het scherm weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om het muziekbestand te selecteren dat 
u wilt afspelen en tik op de toets [Selecteren].

Het muziekbestand wordt afgespeeld.

Music
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Music Browser
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EEN BESTAND VERWIJDEREN UIT DE AFSPEELLIJST
1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu 

te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<Music> (Muziek) te selecteren en tik op de toets [Selecteren].
De lijst <Music> (Muziek) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <Playlists>
(Afspeellijsten) te selecteren en tik op de toets [Selecteren].

De afspeellijsten worden weergegeven.
4. Tik op de toets [Omhoog, Omlaag] om de gewenste 

afspeellijst te selecteren en tik op de toets [Selecteren].
De muziekbestanden die in de geselecteerde afspeellijst zijn 
opgeslagen, worden weergegeven.

5. Tik op de toets [Omhoog, Omlaag] om het bestand te 
selecteren dat u uit de afspeellijst wilt verwijderen, en tik op [ ].

Het menu Afspeellijst wordt weergegeven.
6. Tik op de toets [Omhoog, Omlaag] om <Delete from 

Playlist> (Verw. uit afspeellijst) te selecteren en tik op de 
toets [Selecteren].

Het geselecteerde bestand wordt verwijderd uit de afspeellijst.

ALLE BESTANDEN VERWIJDEREN UIT DE AFSPEELLIJST
Volg stap 1 tot en met 4 hierboven.
5. Tik op [ ].

Het afspeellijstmenu wordt getoond.

6. Tik op de toets [Omhoog, Omlaag] om <Delete All from 
Playlist> (Alles verwijderen uit afspeellijst) te selecteren en tik 
op de toets [Selecteren].

Alle bestanden worden uit de afspeellijst verwijderd.

Het geselecteerde bestand kan niet worden verwijderd als 
deze wordt afgespeeld.

Playlists

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playli..

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playlist

OPMERKING



42 _ muziek beluisteren

HET MUZIEKMENU GEBRUIKEN
Via het menu Muziek heeft u controle over alle facetten van het luisteren 
naar muziek; van het herhalen van nummers en albums tot het kiezen van de 
schermachtergrond tijdens het afspelen van muziek.

Het geluidseffect instellen
U kunt genieten van helderder geluid.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Sound Effect> (Geluidseffect) te selecteren en 
tik op de toets [Selecteren].

Het menu <Sound Effect> (Geluidseffect) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het 
gewenste geluid te selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <Street Mode> (Straatmodus) en <Audio Upscaler> 
(Audio upscaler).

Opties voor geluidseffecten
Street Mode (Straatmodus) : In deze modus kunt u ook buiten luisteren naar 
muziek met een helder geluid, doordat straatgeluiden gefi lterd worden. 
Maak een keuze uit 0~2.
Audio Upscaler : Deze functie herstelt de geluidsbron die verloren is gegaan 
door WMA/MP3-codering tot bijna de originele bron. De Audio Upscaler 
functioneert alleen met muziekbestanden van een lage kwaliteit. U kunt kiezen 
uit <On> (Aan) en <Off> (Uit).

Tik op [ ] om het menu te verlaten.
OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De Digital Natural Sound-engine (DNSe) instellen (DNSe)
Hier selecteert u de juiste geluidsweergave voor elk muziekgenre.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <DNSe>
te selecteren en tik op de toets [Selecteren].

Het menu <DNSe> wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om een 
gewenste DNSe te selecteren en tik op de toets
[Selecteren].

U kunt kiezen uit <Auto>, <Normal> (Normaal), <Studio>, <Rock>, 
<Classical> (Klassiek), <Jazz>, <Ballad>, <Club>, <Rhythm & Blues>, 
<Dance>, <Café>, <Concert>, <Church> (Kerk) en <myDNSe>.
<Auto> zal automatisch de bijbehorende DNSe-modus selecteren als er 
informatie over het muziekgenre is toegevoegd aan de ID3-tag van het 
muziekbestand.
Als u <myDNSe> selecteert, kunt u een gebruikers-DNSe opgeven. Zie 
pagina 44.

Wat is DNSe?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar 
luistert.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren
U kunt een gebruikers-DNSe instellen op uw speler of de gebruikers-
DNSe overbrengen via <EmoDio>.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <DNSe>
te selecteren en tik op de toets [Selecteren].

Het menu <DNSe> (DNSe) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
<myDNSe> te selecteren en tik op de toets
[Selecteren].

De gebruikers-DNSe-lijst wordt weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om een gewenste gebruikers-
DNSe te selecteren en tik op de toets [Selecteren].

De geselecteerde gebruikers-DNSe wordt ingesteld.
U kunt <EQ>, <3D & Bass> (3D en bas), <Concert Hall> (Concertzaal) en 
<Clarity> (Helderheid) instellen als u <myDNSe> hebt geselecteerd. Zie 
pagina 45~48.

Zie <EmoDio> voor meer informatie over het instellen van een gebruikers-
DNSe via <EmoDio>.
U kunt maximaal 97 gebruikers-DNSe-instellingen overbrengen naar de 
speler, met uitzondering van <User 1> (Gebruiker 1) tot en met <User 3> 
(Gebruiker 3).

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)

<EQ>
U kunt de individuele geluidsfrequenties naar wens instellen.
1. Tik op de toets [Omhoog, Omlaag] om het 

gewenste gebruikers-DNSe-menu te selecteren en 
tik op [ ].

Het gebruikers-DNSe-menu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <EQ>
(Equalizer) te selecteren en tik op de toets
[Selecteren].

Het instellingenscherm <EQ> wordt weergegeven.

3. Tik op de toets [Links, Rechts] om de frequentie 
te selecteren die u wilt aanpassen en tik op de toets [Omhoog, 
Omlaag] om het niveau van de geselecteerde frequentie aan te 
passen.

U kunt kiezen uit <–10 - +10> voor het niveau van de geselecteerde frequentie.

4. Tik op de toets [Selecteren].
De instelling is voltooid.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)
<3D & BASS> (3D en bas)
U kunt het 3D-surroundgeluid en het basniveau instellen.
1. Tik op de toets [Omhoog, Omlaag] om het 

gewenste gebruikers-DNSe-menu te selecteren en 
tik op [ ].

Het gebruikers-DNSe-menu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<3D & BASS> (3D en Bas) te selecteren en tik op 
de toets [Selecteren].

Het instellingenscherm <3D & BASS> (3D en bas) 
wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <3D> of <BASS> (Bas) te 
selecteren en tik op de toets [Omhoog, Omlaag].

Voor <3D> en <Bass> (Bas) kunt u kiezen uit <0-4>.

4. Tik op de toets [Selecteren].
De instelling is voltooid.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)

<Concert Hall> (Concertzaal)
U kunt de grootte en het niveau van de concertzaal aanpassen alsof u 
naar de muziek luistert in een echte concertzaal.
1. Tik op de toets [Omhoog, Omlaag] om het 

gewenste gebruikers-DNSe-menu te selecteren en 
tik op [ ].

Het gebruikers-DNSe-menu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Concert Hall> (Concertzaal) te selecteren en tik 
op de toets [Selecteren].

Het instellingenscherm <Concert Hall> (Concertzaal) 
wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Size> (Grootte) of <Level>
(Niveau) te selecteren en tik op de toets [Omhoog, Omlaag].

Voor <Size> (Grootte) en <Level> (Niveau) kunt u kiezen uit <0-3>.

4. Tik op de toets [Selecteren].
De instelling is voltooid.

Afhankelijk van de muziekbestanden kan het selecteren van <Concert 
Hall> (Concertzaal) andere geluidseffecten uitschakelen.OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
myDNSe selecteren (Vervolg)

<Clarity> (Helderheid)
Geniet van een helderder geluid met verbeterde kwaliteit. 
1. Tik op de toets [Omhoog, Omlaag] om het 

gewenste gebruikers-DNSe-menu te selecteren en 
tik op [ ].

Het gebruikers-DNSe-menu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Clarity>
(Helderheid) te selecteren en tik op de toets
[Selecteren].

Het instellingscherm <Clarity> (Helderheid) wordt 
weergegeven.
U kunt kiezen uit <0-2>.

3. Tik op de toets [Omhoog, Omlaag] om het gewenste niveau te 
selecteren en tik op de toets [Selecteren].

De instelling is voltooid.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
De afspeelmodus instellen
De afspeelmodus selecteren, zoals de herhaalinstellingen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Play Mode> (Afspeelmodus) te selecteren en tik 
op de toets [Selecteren].

Het menu <Play Mode> (Afspeelmodus) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om
een gewenste afspeelmodus te selecteren en tik op de toets
[Selecteren].

Opties voor afspeelmodus
Normal (Normaal) : Alle bestanden in de huidige muzieklijst worden een keer 

op volgorde afgespeeld.
Repeat (Herhaal) : Alle bestanden in de huidige muzieklijst worden 

herhaaldelijk afgespeeld.
Repeat One (Eén herhalen) : Één bestand wordt herhaaldelijk afgespeeld.
Shuffl e : Alle bestanden in de huidige muzieklijst worden in willekeurige 

volgorde herhaaldelijk afgespeeld.

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
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Repeat A-B Mode On
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het muziekafspeelscherm selecteren
Kies een achtergrondafbeelding uit de geboden mogelijkheden of kies uw eigen 
achtergrondafbeelding. Deze wordt weergegeven terwijl u naar muziek luistert.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om

<Music Play Screen> (Muziekafspeelscherm) te 
selecteren en tik op de toets [Selecteren].

Het menu <Music Play Screen> (Muziekafspeelscherm) 
wordt weergegeven.

3. Tik op de toets [Links, Rechts] om een gewenst 
muziekafspeelscherm te selecteren en tik op de toets
[Selecteren].

Opties voor muziekafspeelscherm
Maak een keuze uit <Refl ection> (Refl ectie), <Auto>, <Passionate> (Passie), 
<Sweet> (Lief), <Quiet> (Rustig), <Cheerful> (Vrolijk), <Album Art> (Albumontw) en 
<Album Info> (Albuminfo).
Auto : wisselt automatisch tussen muziekafspeelschermen aan de hand van de ID3-
taginformatie van het muziekbestand.
Album Art (Albumontw.) : Een afbeelding van de cd-hoes wordt weergegeven 
als deze informatie is opgenomen in de ID3-taginformatie van het muziekbestand. 
Afbeeldingen van cd-hoesjes worden ondersteund als deze niet groter zijn dan 200 
pixels (horizontaal) x 200 pixels (verticaal).
Album Info. (Albuminfo.) : Informatie over de naam van de artiest, het album 
en het genre wordt weergegeven als ID3-taginformatie is opgeslagen in het 
muziekbestand.

Wat is een ID3-parameter?
Dit is een tag in een MP3-bestand die informatie bevat over het bestand, zoals 
de titel, de artiest, het album, het jaar, het genre en een veld voor opmerkingen.

OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)

De afspeelsnelheid instellen
U kunt de afspeelsnelheid van uw favoriete muziek versnellen of vertragen.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Play Speed> (Afspeelsnelheid) te selecteren en 
tik op de toets [Selecteren].

Het menu <Play Speed> (Afspeelsnelheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om een 
gewenste afspeelsnelheid te selecteren en tik op 
de toets [Selecteren].

Maak een keuze uit <Slow3> (Traag3), <Slow2> (Traag2), <Slow1> 
(Traag1), <Normal> (Normaal), <Fast1> (Snel1), <Fast2> (Snel2), <Fast3> 
(Snel3).

Music
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Het interval voor overslaan instellen
U kunt snel vooruit door een bestand bladeren met verschillende 
intervallen. Sla een heel bestand over of meerdere seconden tegelijk.
1. Tik op [ ] terwijl u naar muziek luistert.

Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Skip Interval> (Tijdverschuivingsinterval) te 
selecteren en tik op de toets [Selecteren].

Het menu <Skip interval> (Tijdverschuivingsinterval) 
wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om een 
gewenste tijdverschuivingsinterval te selecteren en tik op de toets
[Selecteren].

U kunt kiezen uit <1 Song>(1 nr.), <5sec>, <10sec>, <30sec> en <1min>. 

Als het bestand is opgenomen met een variabele bitrate (VBR), komt het 
tijdverschuivingsinterval mogelijk niet precies overeen met wat u hebt ingesteld.OPMERKING
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HET MUZIEKMENU GEBRUIKEN (Vervolg)
Een gedeelte herhalen
Deze functie stelt u in staat om een bepaald gedeelte van een nummer 
meerdere keren achter elkaar te beluisteren. Dit wordt aanbevolen bij 
taalverwerving.
1. Tik op [ ]  op het gewenste punt terwijl u naar 

muziek aan het luisteren bent.
Het menu <Music> (Muziek) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Repeat
A-B Mode On> (A-B modus herhalen aan) te 
selecteren en tik op de toets [Selecteren].

Het instelscherm Fragment herhalen wordt 
weergegeven.

3. Tik op [ ] aan het begin van het fragment dat u 
wilt herhalen.

Het startpunt wordt ingesteld en op de statusbalk voor het afspelen 
verschijnt < >.

4. Tik nogmaals op [ ] om het eind van het fragment op te geven dat 
u wilt herhalen.

Op de statusbalk voor het afspelen wordt < > weergegeven en het 
opgegeven gedeelte wordt herhaaldelijk afgespeeld.

Herhaling annuleren
1. Tik tijdens het herhalen van het fragment op [ ].

Het herhalen van het gedeelte wordt geannuleerd.

Het herhalen van een gedeelte wordt in het volgende geval automatisch 
geannuleerd.
- Het startpunt van het te herhalen gedeelte is ingesteld, maar het eindpunt 

is niet ingesteld voor het einde van het huidige nummer.
- Indien het eindpunt is ingesteld voor minder dan 3 seconden om af te 

spelen na het beginpunt.

OPMERKING
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een video bekijken
Voordat u begint! - De koptelefoon aansluiten, de speler aanzetten en de batterij 
controleren.
Een videobestand naar de speler overbrengen met <EmoDio>.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

EEN VIDEO BEKIJKEN
1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te 

gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om <Videos>

(Video’s) te selecteren en tik op de toets [Selecteren].
De lijst met video’s wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het bestand te selecteren 
dat u wilt afspelen en tik op de toets [Selecteren].

 Het geselecteerde videobestand wordt horizontaal afgespeeld.

PAUZEREN
1. Tik op de toets [Selecteren] tijdens het 

afspelen van de video.
Het afspelen wordt onderbroken.

2. Tik nogmaals op de toets [Selecteren].
Het afspelen wordt hervat vanaf het punt 
waarop het werd onderbroken.

Wanneer u een videobestand naar de speler overbrengt met <EmoDio> (EmoDio), 
wordt het bestand vóór de overdracht geconverteerd naar de indeling SVI. Tevens 
wordt de bestandsgrootte aangepast. Raadpleeg <EmoDio> voor meer informatie.

OPMERKING
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NAAR EEN SPECIFIEK FRAME GAAN
1. Houd in de horizontale weergave de toets [Links, 

Rechts] ingedrukt.
Hierdoor kunt u in het huidige videobestand vooruit en 
achteruit spoelen.

2. Haal uw vinger van de toets nadat u naar de 
gewenste positie hebt gespoeld.

De video begint op dit punt af te spelen.

HET VORIGE VIDEOBESTAND AFSPELEN
Tik binnen 3 seconden nadat het huidige video bestand 
is begonnen met afspelen, op de toets [Links].
Tik 3 seconden nadat het huidige bestand is begonnen 
met afspelen, tweemaal op de toets [Links].

De vorige video wordt nu afgespeeld.

HET VOLGENDE VIDEOBESTAND AFSPELEN
Tik op de toets [Rechts].

Het volgende bestand wordt nu afgespeeld.

Video Track 1

Video Track 1

Video Track 2
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HET VIDEOMENU GEBRUIKEN
Een bladwijzer instellen
Als u een bladwijzer instelt, kunt u deze plek later makkelijk terugvinden.
1. Tik tijdens het afspelen van video op [ ]

tijdens de gewenste scène.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Add
Bookmark> (Bladwijzer toev.) te selecteren en 
tik op de toets [Selecteren].

Het huidige afspeel-/stoppunt wordt aan de 
bladwijzer toegevoegd. 
U ziet het symbool [  ] op de afspeelstatusbalk.

Het venster Overschrijven verschijnt als er al eerder een bladwijzer 
is ingesteld. Als u <Yes> (Ja) selecteert, wordt de eerder ingestelde 
bladwijzer verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per videobestand instellen met een maximum van 50 
bladwijzers.

Naar de bladwijzer gaan (afspelen)/de bladwijzer verwijderen
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Go to Bookmark> (Ga naar bladwijzer) 
of <Delete Bookmark> (Bladwijzer verw.) 
te selecteren en tik vervolgens op de toets
[Selecteren].

Als u <Go to Bookmark> (Ga naar bladwijzer) hebt geselecteerd, gaat de 
speler naar de geselecteerde bladwijzer en wordt het afspelen gestart.
Met <Delete Bookmark> (Bladwijzer verw.) verwijdert u de geselecteerde 
bladwijzer uit het videobestand.

Tik op [ ] om het menu te verlaten.

OPMERKING
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HET VIDEOMENU GEBRUIKEN (Vervolg)
De helderheid wijzigen
U kunt de helderheid van het scherm aanpassen.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Brightness> (Helderheid) te selecteren en 
tik op de toets [Selecteren].

Het menu <Brightness> (Helderheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste helderheid te 
selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <0~10>.
De Digital Natural Sound-engine (DNSe) instellen
De juiste geluidsweergave voor elk videogenre selecteren.
1. Tik op [ ] terwijl een videobestand wordt 

afgespeeld.
Het menu <Video> wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<DNSe> te selecteren en tik op de toets
[Selecteren].

Het menu <DNSe> wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om een gewenste DNSe te 

selecteren en tik op de toets [Selecteren].
U kunt kiezen uit <Normal> (Normaal), <Drama> en <Action> (Hand.).

Wat is SVI?
Digital Natural Sound Engine (DNSe) is een functie voor geluidseffecten 
voor MP3-spelers die is ontwikkeld door Samsung. Dit biedt verschillende 
geluidsinstellingen voor het verbeteren van het type muziek waar u naar luistert.

Add Bookmark
Go to Bookmark
Delete Bookmark
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Delete Bookmark
Brightness
DNSe
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afbeeldingen bekijken
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Breng beeldbestanden over naar de speler via <EmoDio>.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

AFBEELDINGEN BEKIJKEN
1. Houd [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<Pictures> (Afbeeldingen) te selecteren en tik op de toets
[Selecteren].

Het voorbeeldscherm voor afbeeldingen wordt weergegeven.
3. Tik op de toets [Links, Rechts, Omhoog, Omlaag] om de 

afbeelding te selecteren die u wilt weergeven en tik op de 
toets [Selecteren].

De geselecteerde afbeelding wordt weergegeven.
Tik op [ ] om naar het vorige venster te gaan.

Naar de vorige/volgende 
afbeelding gaan
Tik in de horizontale weergave op de 
toets [Links, Rechts] ingedrukt.

De vorige/volgende afbeelding wordt 
weergegeven.

Wanneer u een afbeelding naar de speler 
overbrengt met <EmoDio> (EmoDio), wordt 
het bestand vóór de overdracht geconverteerd 
naar JPG-indeling. Tevens wordt de 
bestandsgrootte aangepast.
Raadpleeg <EmoDio> voor meer informatie.

 wordt weergegeven als in de JPG-bestanden de onjuiste miniatuurweergave-
informatie wordt weergegeven.
Sommige afbeeldingen worden langzamer weergegeven dan andere.
U kunt ook een afbeelding zoeken met behulp van de <File Browser> (Bestandsbrowser). Zie pagina 21.

OPMERKING

OPMERKING

Toets [Omhoog, Omlaag]

Toets [Links, Rechts]
<In horizontale weergave>
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OPMERKING

HET AFBEELDINGSMENU GEBRUIKEN
Afbeeldingen bekijken tijdens het luisteren naar 
muziek of FM-radio
U kunt naar muziek of de FM-radio luisteren terwijl u afbeeldingen 
bekijkt.
1. Tik op [ ] terwijl u een foto bekijkt.

Het menu <Picture> (Afbeeld.) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om 

<Music On> (Muziek aan) of <FM Radio On>
(FM-radio aan) te selecteren en tik op de toets
[Selecteren].

Elke tik op de toetsen <Music On> (Muziek aan) 
of <FM Radio On> (FM-radio aan) schakelt het geluid in of uit.

Een diavoorstelling bekijken
Instructie 1
1. Tik op de toets [Selecteren] tijdens het bekijken 

van een afbeelding.
U ziet [ ] op het scherm en vervolgens wordt de 
diavoorstelling gestart.

Instructie 2
1. Tik op [ ] in de voorbeeldmodus voor afbeeldingen.

Het scherm < Start Slideshow > (Diavertoning starten) 
wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Start
Slideshow> (Diavoorstelling starten) te selecteren en tik op de toets
[Selecteren].
 U ziet [ ] op het scherm en vervolgens wordt de diavoorstelling gestart.

Tik op [ ] om het menu te verlaten.

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
De diavoorstelling beëindigen

Instructie 1
1. Tik in de diavoorstellingsmodus op de toets

[Selecteren].
De diavoorstelling wordt gestopt.

Instructie 2
1. Tik tijdens de diavoorstelling op [ ].

Het menu <Picture> (Afbeeld.) wordt
   weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Stop Slideshow>
(Diavoorstelling stoppen) te selecteren en tik op de toets
[Selecteren].

De diavoorstelling wordt gestopt.

De afspeelsnelheid van de diavoorstelling instellen
1. Tik in de diavoorstellingsmodus op [ ].

Het diavoorstellingsmenu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Slideshow Speed> (Snelheid diavoorstelling) 
te selecteren en tik op de toets [Selecteren].

Het menu <Slideshow speed> (Snelheid 
diavoorst.) wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om een gewenste afspeelsnelheid 
te selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <Fast> (Snel), <Normal> (Normaal) en <Slow> (Traag).

Stop Sildeshow
Slideshow Speed
Transition Effect

Stop Sildeshow
Slideshow Speed
Transition Effect
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding vergroten
U kunt inzoomen op een afbeelding.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het afbeeldingsmenu wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Zoom> (Zoomen) te selecteren en tik op de 
toets [Selecteren].

Het menu <Zoom> wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste zoomfactor te 
selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <100%>, <200%> en <400%>.

4. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om naar het 
gedeelte van de afbeelding te gaan waarop u wilt inzoomen.

Het zoomen annuleren

Tik op de toets [Selecteren] tijdens het bekijken van een vergrootte 
afbeelding.

Hiermee keert u terug naar de normale afmeting.

Het kan iets langer duren om in te zoomen op een grote afbeelding.
OPMERKING
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Een afbeelding draaien
U kunt een afbeelding desgewenst draaien.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het menu <Picture> (Afbeeld.) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Rotate> (Roteren) te selecteren en tik op de 
toets [Selecteren].

Het menu <Rotate> (Draaien) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste hoek te 
selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <Left 90°> (Links 90°), <Right 90°> (Rechts 90°) en <180°>. 

De functie Automatisch draaien instellen
Automatisch draaien draait de afbeelding naar verhouding, zodat 
deze kan worden weergegeven op het scherm in de grootst mogelijke 
weergave.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het menu <Picture> (Afbeeld.) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om

<Auto Pivot> (Autom. draaien) te selecteren 
en tik op de toets [Selecteren].

Het menu <Auto Pivot> (Autom. draaien) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om <On> (Aan) te selecteren 
en tik op de toets [Selecteren].

Autom. draaien wordt ingesteld.
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HET AFBEELDINGSMENU GEBRUIKEN (Vervolg)
Het overgangseffect wijzigen
U kunt het overgangseffect zodanig instellen dat de huidige afbeelding 
wisselt tussen de vorige en de volgende afbeelding.
1. Tik op [ ] terwijl u een afbeelding bekijkt.

Het menu <Picture> (Afbeeld.) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om 

<Transition Effect> (Overgangseffect) te 
selecteren en tik op de toets [Selecteren].

Het menu <Transition Effect> (Overgangseffect) 
wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het gewenste overgangseffect 
te selecteren en tik op de toets [Selecteren].

Maak een keuze uit <Off> (Uit), <Auto> , <Cover> (Bedekken), <Fade> 
(Vervagen), <Push> (Duwen), <Split> (Splitsen), <Blinds> (Blinderen) en 
<Zoom> (In/uitzoomen).

Een afbeelding als achtergrondafbeelding selecteren
U kunt een afbeelding naar keuze instellen als achtergrond voor het scherm.
1. Selecteer het afbeeldingsbestand dat u als 

achtergrondafbeelding wilt instellen en tik op [ ].
Het menu <Picture> (Afbeeld.) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Select as My Skin> (Selecteren als mijn skin) te 
selecteren en tik op de toets [Selecteren].

Het bevestigingsvenster wordt weergegeven.
3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te selecteren en tik op de 

toets [Selecteren].
De geselecteerde afbeelding wordt ingesteld als achtergrondafbeelding.
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tekst lezen
Met Prime Pack kunt u meerdere functies gebruiken, bijvoorbeeld voor 
het lezen van tekst, spelletjes spelen en het instellen van het alarm.

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Breng tekstbestanden over naar de speler via <EmoDio>.
Stel de voorkeurtaal voor de tekst in. Zie pagina 69.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

TEKST LEZEN
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om <Texts>

(Tekst) te selecteren en tik op de toets [Selecteren].
De lijst met tekstbestanden wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het gewenste tekstbestand 
te selecteren en tik op de toets [Selecteren].

De tekst wordt op het scherm weergegeven.
Houd de toets [Selecteren] ingedrukt voor een weergave in het 
volledige scherm. Houd de toets [Selecteren] nogmaals ingedrukt om terug te keren 
naar het vorige scherm.

Naar de vorige/volgende pagina gaan
Tik op de toets [Links, Rechts].

Houd de toets [Links, Rechts] ingedrukt om door de vorige of volgende pagina’s 
te bladeren.

U kunt ook een tekstbestand zoeken met behulp van de <File Browser> 
(Bestandsbrowser). Zie pagina 21.
Uw MP3-speler ondersteunt de bestandsindeling TXT in de tekstmodus.

OPMERKING

OPMERKING
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HET TEKSTMENU GEBRUIKEN
Tekst lezen tijdens het luisteren naar muziek of FM-radio
U kunt naar muziek of de FM-radio luisteren terwijl u tekst leest.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Music On> (Muziek aan) of <FM Radio On>
(FM-radio aan) te selecteren en tik op de toets
[Selecteren].

Elke tik op de toetsen <Music On> (Muziek aan) of <FM 
Radio On> (FM-radio aan) schakelt het geluid in of uit.

Naar de eerste pagina gaan
Gebruik deze optie als u de tekst van de eerste pagina wilt bekijken.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Go to 1st page> (Ga naar 1e pagina) te 
selecteren en tik op de toets [Selecteren].

Er wordt een venster weergegeven met daarin de 
bevestiging dat u naar de eerste pagina gaat.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 
selecteren en tik op de toets [Selecteren].

U gaat naar de eerste pagina.

Tik op [ ] om het menu te verlaten.
OPMERKING
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HET TEKSTMENU GEBRUIKEN (Vervolg)
Een bladwijzer instellen
Stel een bladwijzer in om een volgende keer terug te gaan naar een 
bepaald punt in de tekst.
1. Tik tijdens het lezen van een tekst op de gewenste 

pagina op [ ].
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Add Bookmark> (Bladwijzer toev.) te selecteren 
en tik op de toets [Selecteren].

In het huidige tekstscherm wordt een bladwijzer 
ingesteld en het symbool 
[ ] wordt linksboven in het scherm weergegeven.

Het venster Overschrijven verschijnt als er al eerder een 
bladwijzer is ingesteld. Als u <Yes> (Ja) selecteert, wordt de eerder ingestelde 
bladwijzer verwijderd en wordt er een nieuwe bladwijzer toegevoegd.
U kunt één bladwijzer per tekstbestand instellen met een maximum van 50 
bladwijzers.

Naar de bladwijzer gaan/de bladwijzer verwijderen
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om 

<Go to Bookmark> (Ga naar bladwijzer) of 
<Delete Bookmark> (Bladwijzer verw.) te selecteren 
en tik vervolgens op de toets [Selecteren].

Als u <Go to Bookmark> (Ga naar bladwijzer) 
selecteert, gaat u naar de geselecteerde bladwijzer. Met 
<Delete Bookmark> (Bladwijzer verw.) verwijdert u de 
geselecteerde bladwijzer uit het tekstbestand.

OPMERKING
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HET TEKSTMENU GEBRUIKEN (VERVOLG)
De kleur van de tekstviewer instellen
Kies in welke kleur u de tekst wilt weergeven.

1. Tik op [ ] terwijl u uw tekst bekijkt.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Text 
Viewer Color> (Kleur tekstviewer) te selecteren 
en tik op de toets [Selecteren].

Het menuvenster <Text Viewer Color>(Kleur 
tekstviewer) wordt weergegeven.

3. Tik op de toets [Links, Rechts] om de gewenste 
kleur voor de tekstviewer te selecteren en tik 
vervolgens op de toets [Selecteren].

U kunt kiezen uit <Type 1> tot en met <Type 6>.

De lettergrootte wijzigen
U kunt de lettergrootte van de tekst wijzigen.

1. Tik op [ ] terwijl u uw tekst bekijkt.
Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Font Size> (Tekengrootte) te selecteren en tik op 
de toets [Selecteren].

Het menu <Font Size> (Lettergr.) wordt weergegeven.
3. Tik op de toets [Links, Rechts] om de gewenste 

tekengrootte te selecteren en tik vervolgens op de 
toets [Selecteren].

U kunt kiezen ui <Small> (Klein), <Medium> en <Large> (Groot).
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HET TEKSTMENU GEBRUIKEN (Vervolg)
Het type tekstviewer instellen
U kunt tekst horizontaal of verticaal weergeven.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<View Type> (Weergavetype) te selecteren en tik 
op de toets [Selecteren].

Het menu <View Type> (Weergavetype) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om 
het gewenste weergavetype te selecteren en tik op de toets
[Selecteren].

U kunt kiezen uit <Normal> (Normaal) en <Horizontal> (Horizontaal).
Selecteer <Normal> (Normaal) om tekst verticaal weer te geven en selecteer 
<Horizontal> (Horizontaal) om de schermweergave horizontaal te draaien.
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HET TEKSTMENU GEBRUIKEN (Vervolg)
De teksttaal instellen
U kunt een taal instellen voor de tekst die u wilt bekijken.
1. Tik op [ ] terwijl u uw tekst bekijkt.

Het menu <Text> (Tekst) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Language> (Taal) te selecteren en tik op de 
toets [Selecteren].

De lijst <Language> (Taal) wordt weergegeven.
<English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, 
<Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, 
<Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, 
<Turkish>, <Vietnamese>.

3. Tik op de toets [Omhoog, Omlaag] om de gewenste taal te 
selecteren en tik op de toets [Selecteren].

U kunt de tekst nu in de geselecteerde taal bekijken.

De ondersteunde talen kunnen worden gewijzigd of toegevoegd.
OPMERKING
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HET TEKSTMENU GEBRUIKEN (Vervolg)
Naar TTS (Text to Speech) luisteren
Met de TTS-functie van <EmoDio> kunt u een tekstbestand converteren 
naar een TTS-bestand en het bestand afspelen.

Voordat u begint - Breng de TTS-bestanden over naar de speler via 
<EmoDio>.

1. Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te 
gaan.

2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om <Texts>
(Tekst) te selecteren en tik op de toets [Selecteren].

De lijst met TTS-bestanden wordt weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om een gedownload TTS te 
selecteren en tik op de toets [Selecteren].

U kunt het bestand afspelen.

U kunt de afspeelsnelheid en de tijdverschuivingsinterval aanpassen door 
te tikken op [ ].

Zie <EmoDio> voor meer informatie over de TTS-functie van <EmoDio>.
OPMERKING
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naar de FM-radio luisteren
Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

NAAR DE FM-RADIO LUISTEREN
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag] om <FM Radio> te 

selecteren en tik op de toets [Selecteren].
FM-radio wordt ontvangen.

DE DEMPFUNCTIE GEBRUIKEN
1. Tik op de toets [Selecteren] tijdens het luisteren naar de FM-radio.

Het geluid wordt onderdrukt.
2. Tik nogmaals op de toets [Selecteren] om het luisteren te hervatten.

Sluit altijd de oortelefoon aan op uw speler als u frequenties zoekt of instelt.
De oortelefoon wordt gebruikt als antenne voor het ontvangen van FM-radio.
In gebieden met slechte ontvangst worden mogelijk geen FM-stations gevonden.

OPMERKING
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Auto Searching

News
Today Headline

FM-STATIONS ZOEKEN
1. Activeer de handmatige modus en houd de toets

[Links, Rechts] ingedrukt en laat deze vervolgens los.
Het zoeken stopt bij de eerstvolgende frequentie nadat u de toets 
hebt losgelaten.

OF,

1. Tik op de toets [Links, Rechts] om in de handmatige 
modus stap voor stap door de frequenties te bladeren.

Wanneer u de toets indrukt wordt er naar een frequentie gezocht.
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HET MENU FM-RADIO GEBRUIKEN
Overschakelen naar de stand met voorinstellingen
Selecteer deze stand als u de opgeslagen FM-voorinstellingen wilt 
afzoeken.
1. Tik in de handmatige stand op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Go to Preset Mode> (Ga naar voorinstellingsmodus) 
te selecteren en tik op de toets [Selecteren].

<Preset> wordt op het scherm weergegeven.

Als er vooraf geen frequenties zijn ingesteld, 
schakelt de speler niet naar de Preset mode 
(Voorinstellingsmodus).

Overschakelen naar de handmatige stand
Selecteer deze stand als u de FM-band handmatig per frequentie wilt 
afzoeken.
1. Tik in de stand met voorinstellingen op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Go to Manual Mode> (Ga naar handm. modus) te 
selecteren en tik op de toets [Selecteren].

<Manual> (Handm.) wordt op het scherm weergegeven.

OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen
U kunt maximaal 30 stations opslaan in het geheugen van uw 
MP3-speler en deze vervolgens met één druk op de knop oproepen. 
Laat de MP3-speler met het handmatige proces alleen de zenders 
kiezen die u wilt, of sla automatisch alle gevonden lokale zenders op. 
Manual (Handmatig) : alleen de stations kiezen die u wilt opslaan
1. Tik op de toets [Links, Rechts] om in de 

handmatige modus een frequentie te selecteren 
die u wilt instellen en tik op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om
<Add to Preset> (Toev. aan voorinstelling) te 
selecteren en tik op de toets [Selecteren].

De geselecteerde frequentie wordt aan de lijst met 
voorkeuzestations toegevoegd.

3. Als u andere frequenties wilt instellen, volgt u de stappen 1-2 hierboven.

Als een bepaalde frequentie al is voorgeprogrammeerd, wordt de instelling 
geannuleerd.OPMERKING
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Stations opslaan in het voorkeuzegeheugen (Vervolg)
Automatisch : automatisch alle zenders opslaan die de speler 
ontvangt
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om <Auto
Preset> (Autom. voorinst.) te selecteren en tik op de 
toets [Selecteren].

Het bevestigingsvenster wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Yes> (Ja) te 
selecteren en tik op de toets [Selecteren].

Er worden maximaal 30 frequenties automatisch ingesteld.

Automatische voorinstelling annuleren
Tik op de toets [Selecteren] tijdens het proces als u de automatische 
voorinstelling wilt annuleren.

Het automatisch voorprogrammeren wordt geannuleerd en alleen de frequenties 
die tot op dat moment zijn ingesteld, worden opgeslagen.

U kunt de opgeslagen stations opnieuw instellen als u de MP3-speler in 
een andere stad gaat gebruiken. Als u de opgeslagen stations wilt wissen 
en nieuwe wilt laten opslaan, hoeft u het proces slechts te herhalen.

OPMERKING

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region



76 _ naar de FM-radio luisteren

HET MENU FM-RADIO GEBRUIKEN (Vervolg)

Luisteren naar een voorkeuzestation
Tik in de voorinstellingsmodus op de toets [Links,
Rechts] om door de voorgeprogrammeerde stations 
te bladeren.

U kunt naar de opgeslagen radiofrequentie luisteren.

Een voorkeuzestation wissen
Volg de onderstaande stappen om frequenties te verwijderen terwijl u 
naar de radio luistert.
1. Tik in de voorinstellingsmodus op [Links, Rechts] om 

naar de voorgeprogrammeerde frequentie te zoeken die 
u wilt verwijderen, en tik vervolgens op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<Delete from Preset> (Verw. uit voorinst.) te 
selecteren en tik op de toets [Selecteren].

De geselecteerde frequentie wordt verwijderd.

3. Als u andere voorgeprogrammeerde frequenties  wilt verwijderen, 
volgt u de stappen 1-2 hierboven.

Go to Manual Mode
Delete from Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

News
Today Headline
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-radio-uitzending opnemen
U kunt op elk gewenst moment een FM-radio-uitzending opnemen terwijl u naar 
de radio luistert.
1. Tik op de toets [Links, Rechts] om in de modus voor 

FM-radio een op te nemen frequentie te selecteren en 
tik op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.
2. Tik op de toets [Omhoog, Omlaag] om 

<Start Recording> (Opname starten) te selecteren en 
tik op de toets [Selecteren].

Er wordt een automatisch gemaakt bestand weergegeven en 
de opname start.

De opname beëindigen
1. Tik tijdens het opnemen op de toets [Selecteren].

U wordt gevraagd of u het bestand dat u zojuist heeft 
opgenomen, wilt beluisteren.

2. Tik op de toets [Links, Rechts] om <Yes> (Ja) of <No>
(Nee) te selecteren en tik op de toets [Selecteren].

Als u <Yes> (Ja) kiest, wordt het zojuist opgenomen bestand 
afgespeeld.
Als u <No> (Nee) kiest, wordt het zojuist opgenomen bestand 
niet afgespeeld.

Het opgenomen bestand wordt opgeslagen in <File 
Browser> (Bestandsbrowser)  <Recorded Files> (Opgenomen Bestanden)
Elk FM-opnamebestand is maximaal 5 uur lang.
U kunt maximaal 999 FM-opnamen opslaan.
U kunt maximaal ongeveer 15 uur aan opnamen maken. (gebaseerd op 128 Kbps, 1 GB)
De bestandsnaam van de opname wordt automatisch samengesteld, bijvoorbeeld 
“FM_JJMMDD_XXX.MP3”. “FM” betekent FM-opname, “JJMMDD” verwijst naar de 
opnamedatum en “XXX” is het nummer van het opnamebestand.

OPMERKING

FM Record

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
FM-ontvangst instellen
Met de instelling <FM Sensitivity> (FM Gevoeligheid) kunt u de 
ontvangstgevoeligheid instellen.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<FM Sensitivity> (FM-gevoeligheid) te selecteren 
en tik op de toets [Selecteren].

Het menu <FM Sensitivity> (FM Gevoeligheid) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om het 
gewenste zoekniveau te selecteren en tik op de 
toets [Selecteren].

U kunt kiezen uit <High> (Hoog), <Middle> (Midden) en <Low> (Laag).
Als u <High> (Hoog) selecteert, worden meer frequenties ontvangen.

Tik op [ ] om het menu te verlaten.
OPMERKING

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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HET MENU FM-RADIO GEBRUIKEN (Vervolg)
Een FM-regio instellen
U kunt een FM-regio instellen voor reizen naar het buitenland.
1. Tik in de modus FM Radio op [ ].

Het menu <FM Radio> (FM-radio) wordt weergegeven.

2. Tik op de toets [Omhoog, Omlaag] om 
<FM Region> (FM-regio) te selecteren en tik op 
de toets [Selecteren].

Het menu <FM Region> (FM-regio) wordt 
weergegeven.

3. Tik op de toets [Omhoog, Omlaag] om uw regio 
voor FM-radio te selecteren en tik op de toets
[Selecteren].

U kunt kiezen uit <Korea/US> (Korea/VS), <Japan> en <Other Countries> 
(Andere Landen).

Opgeslagen radiofrequenties worden gewist wanneer u de instelling <FM 
Region> (FM-regio) op de speler wijzigt.

De FM-regio kan worden verwijderd of gewijzigd overeenkomstig de 
doelregio voor de speler. 

Frequentiebereik naar regio
- Korea/US (Korea/VS) : FM-frequenties in 100 kHz-spelers zoeken tussen 87.5 

MHz~108.0 MHz.
- Japan : FM-frequenties in 100 kHz-spelers zoeken tussen 76.0 MHz~108.0 

MHz.
- Other Countries (Andere Landen) : FM-frequenties in 50 kHz-spelers zoeken 

tussen 87.50 MHz~108.00 MHz.

OPMERKING

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region
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Datacasts 1/4

Datacast 1
Datacast 2
Datacast 3
Datacast 4

datacasts weergeven
DATACASTS WEERGEVEN
U kunt aan <Datacasts> toegevoegde kanaalberichten weergeven.

Voordat u begint! - Breng de gewenste kanaalberichten over naar de speler via <EmoDio>.

Wat zijn datacasts?
U kunt automatisch bijgewerkte informatie ontvangen zonder telkens naar uw veelbezochte 
nieuws-, blog- en UCC-sites te hoeven gaan.
Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 
<Datacasts> (Datacasts) te selecteren en tik op de toets
[Selecteren].

De lijst met datacasts wordt weergegeven.
3. Tik op de toets [Omhoog, Omlaag] om de gewenste kanalenlijst 

te selecteren en tik op de toets [Selecteren].
De lijst met bestanden wordt weergegeven.

pictogram   : Hoofdtekst van het 
overgebrachte bericht
pictogram  : Afbeeldingsbestand

pictogram   : 
Muziekbestand
pictogram  : 
Videobestand

4. Tik op de toets [Omhoog, Omlaag] om het gewenste bestand 
te selecteren en tik op de toets [Selecteren].

Het geselecteerde bestand wordt afgespeeld.
Zie <Datacasts> (Datacasts) van <EmoDio> voor meer 
informatie.

OPMERKING

OPMERKING
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de extra functies gebruiken
Met Prime Pack (Hoofdpakket) kunt u genieten van verschillende 
functies als games spelen, stemopname, enz.

Voordat u begint! - De oortelefoon aansluiten, de speler aanzetten en de batterij controleren.

STEMOPNAME
Hiermee kunt u een stemopname maken.

Een stemopname maken
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<Prime Pack> (Hoofdpakket) te selecteren en tik op de 
toets [Selecteren].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.
3. Tik op de toets [Links, Rechts] om <Voice REC>

(stemopname) te selecteren en tik op de toets
[Selecteren].

4. Tik op de toets [Selecteren].
Het opnemen wordt gestart.

Het opgenomen bestand wordt opgeslagen in <File Browser> (Bestandsbrowser) 
 <Recorded Files> (Opgenomen Bestanden)

Elk spraakopnamebestand is maximaal 5 uur lang.
U kunt maximaal 999 bestanden voor spraakopnamen opslaan.
U kunt maximaal ongeveer 15 uur aan opnamen maken. (gebaseerd op 128 Kbps, 1 GB)
De bestandsnaam van de opname wordt automatisch samengesteld, bijvoorbeeld 
“VCE_JJMMDD_XXX.MP3”. “VCE” betekent spraakopname, “JJMMDD” verwijst 
naar de opnamedatum en “XXX” is het nummer van het opnamebestand.

OPMERKING
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STEMOPNAME (Vervolg)

De geluidsopname beëindigen
1. Tik tijdens het opnemen op de toets [Selecteren].

U wordt gevraagd of u het bestand dat u zojuist heeft 
opgenomen, wilt beluisteren.

2. Tik op de toets [Links, Rechts] om <Yes> (Ja) 
of <No> (Nee) te selecteren en tik op de toets
[Selecteren].

Als u <Yes> (Ja) kiest, wordt het zojuist opgenomen 
bestand afgespeeld.
Als u <No> (Nee) kiest, wordt het zojuist opgenomen 
bestand niet afgespeeld.

Plaats de microfoon niet te ver weg of te dichtbij uw mond tijdens de 
opname. Dit kan ten koste gaan van de opnamekwaliteit.
Spraakopname werkt niet goed als de batterij bijna leeg is.

Voice Record

LET OP
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VIDEOGAMES SPELEN
Op uw mp3-speler staan al spannende spelletjes!

Tik op [ ] om naar het vorige scherm te gaan.
Houd  [ ] ingedrukt om naar het scherm met het hoofdmenu te gaan.

1. Houd [ ] ingedrukt om naar het scherm met het 
hoofdmenu te gaan.

2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 
<Prime Pack> (Hoofdpakket) te selecteren en tik op de 
toets [Selecteren].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.

3. Tik op de toets [Links, Rechts] om <Games> (Spel) te 
selecteren en tik op de toets [Selecteren].

De lijst met spelletjes wordt weergegeven.

4. Tik op de toets [Omhoog, Omlaag] om het gewenste spel te selecteren en 
tik op de toets [Selecteren].

BOMB BOMB
Dit een echte hersenkraker waarbij u de volgorde van drie blokken moet 
veranderen, zodat de kleur van het weergegeven blok overeenkomt 
met die van de gestapelde blokken en de blokken 
worden verwijderd. Probeer zoveel mogelijk blokken 
te verwijderen.
Tik op de toets [Links, Rechts] om de blokken naar 
links of naar rechts te verplaatsen.
Tik op de toets [Omhoog] om de positie van de 
blokken horizontaal of verticaal te wijzigen.
Tik op de toets [Omlaag] om de blokken te droppen.

OPMERKING
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VIDEOGAMES SPELEN (Vervolg)
Bubble Smile
U moet een zo hoog mogelijke score behalen door de volgorde van 
drie zeepbellen te veranderen en deze horizontaal of diagonaal te 
combineren.

Tik op de toets [Omhoog, Omlaag, Links, Rechts]
om de combinatie van drie zeepbellen te verplaatsen.
Tik op [ ] om de zeepbellen rechtsom te 
verplaatsen.
Tik op [ ] om de zeepbellen linksom te verplaatsen.
U krijgt alleen punten wanneer u ten minste drie 
zeepbellen combineert.

Chicken Runaway
Bij dit spelletje beweegt u de hen en de kuikens van links naar rechts 
om de ballen zo lang mogelijk te ontwijken en de hen veilig te houden.

Tik op de toets [Links, Rechts] om de hen naar links 
of naar rechts te verplaatsen.

Spelletjes kunnen zonder voorafgaand bericht worden 
toegevoegd of gewijzigd.
Zie de Help-informatie voor meer informatie over het spelen 
van het spel.

OPMERKING
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WERELDKAART METRO WEERGEVEN
U kunt door de wereldkaart van de metro en bekende plaatsen in de buurt van 
het station bladeren.
1. Houd [ ] ingedrukt om naar het scherm met het 

hoofdmenu te gaan.
2. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om 

<Prime Pack> (Hoofdpakket) te selecteren en tik op de 
toets [Selecteren].

De <Prime Pack> (Hoofdpakket)-lijst wordt weergegeven.
3. Tik op de toets [Links, Rechts] om <Subway> (Metro) te 

selecteren en tik op de toets [Selecteren].
Er verschijnt een scherm waarin u een wereldregio kunt selecteren.

4. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om de gewenste regio te 
selecteren en tik op de toets [Selecteren].

U kunt kiezen uit <AMERICA> (AMERIKA), <EUROPE> (EUROPA), <ASIA/
OCEANIA> (AZIË/OCEANIË).
De steden binnen de geselecteerde regio worden weergegeven.

5. Tik op de toets [Links, Rechts] om de gewenste stad te selecteren en tik 
vervolgens op de toets [Selecteren].

De metrokaart van de geselecteerde stad wordt weergegeven.
6. Tik op de toets [Omhoog, Omlaag, Links, Rechts] om een gebied te 

selecteren dat u wilt vergroten en tik op de toets [Selecteren].
Als de uitvergrootte kaart informatie bevat over toeristische attracties naast het 
metrostation, tikt u nogmaals op de toets [Selecteren] om de rode pijl weer te geven. 
Tik op de toets [Omhoog, Omlaag, Links, Rechts] om het gewenste pictogram te 
selecteren en tik op de toets [Selecteren]. U kunt meer te weten komen over de 
toeristische attractie.

Tik op [ ] om terug te keren naar het selectiescherm met de wereldregio’s.
De kaart kan afwijken van de werkelijke metrokaart.OPMERKING
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problemen oplossen
Als u problemen ondervindt met uw nieuwe MP3-speler, vindt 
u mogelijk een oplossing in deze lijst. Als het probleem zich blijft 
voordoen, kunt u contact opnemen met het dichtstbijzijnde Samsung 
Customer Service Center.

PROBLEEM OPLOSSING

Kan de speler niet 
inschakelen.

• De speler kan niet worden ingeschakeld als de 
batterij helemaal leeg is. Laad de batterij op en 
schakel de speler nogmaals in.

• Druk met een scherp voorwerp de 
resetopening in.

De toetsen werken niet.

• Controleer of de schakelaar [ ] naar 
de bovenzijde van de speler wordt geschoven.

• Controleer of u op de juiste toets hebt gedrukt, 
en druk nogmaals op de toets.

• Druk met een scherp voorwerp de 
resetopening in.

Het scherm wordt niet 
ingeschakeld.

• Het scherm is in vol zonlicht mogelijk niet goed 
zichtbaar.

• Als <Display Off> (Display Uit) is geselecteerd 
in <Settings> (Instellingen) <Display>
(Weergave), wordt het scherm uitgeschakeld.
Tik op een willekeurige toets om te zien of het 
wordt ingeschakeld.
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PROBLEEM OPLOSSING

De speler wordt 
uitgeschakeld.

• De speler wordt automatisch uitgeschakeld 
wanneer de batterij helemaal leeg is. Laad de 
batterij op.

• Als u <Auto Power Off> (Autom. uitschakelen) 
selecteert via <Settings> (Instellingen)
<System> (Systeem), zal de speler in de 
pauzestand worden uitgeschakeld. Schakel de 
speler in.

De levensduur van 
de batterij verschilt 
met de levensduur die 
is aangegeven in de 
gebruiksaanwijzing.

• Hoelang de batterij meegaat kan 
variëren, afhankelijk van de geluids- en 
scherminstellingen.

• Wanneer de speler langdurig wordt 
blootgesteld aan lage of hoge temperaturen, 
kan dit ten koste gaan van de levensduur van 
de batterij.

Storingen in de werking 
van EmoDio

• Controleer of uw computer voldoet aan de 
minimum systeemvereisten.

Kan geen verbinding 
met de computer 
maken.

• Controleer of de USB-kabel juist is aangesloten 
en probeer het nogmaals.

• Voer de Windows-update uit op uw computer. 
Selecteer Essentiële updates en Service packs 
en installeer alle updates. Start de computer 
opnieuw op en sluit de speler opnieuw aan.

De overdrachtssnelheid 
van bestanden is te 
laag.

• De overdrachtssnelheid is lager als u meerdere 
programma’s, waaronder <EmoDio>, op 
uw computer uitvoert. Sluit overbodige 
programma’s af en probeer het nog eens.
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PROBLEEM OPLOSSING

De speler speelt niet af

• Controleer of het beschikbare bestand is 
opgeslagen in het geheugen.

• Controleer of het muziekbestand is 
beschadigd.

• Controleer of de batterij voldoende is 
opgeladen.

Het uploaden van 
bestanden werkt niet.

• Controleer of de USB-kabel goed is 
aangesloten. Sluit deze zonodig opnieuw aan.

• Controleer of het geheugen vol is.
• Druk met een scherp voorwerp de 

resetopening in.

Er ontbreken bestanden 
of gegevens.

• Controleer of de USB-kabel is losgeraakt 
tijdens de bestandsoverdracht. Dit kan 
overigens niet alleen leiden tot ernstige 
beschadiging van de bestanden/gegevens, 
maar ook van het product. 
Let goed op, want Samsung is niet 
aansprakelijk voor gegevensverlies.

Abnormale afspeeltijd 
tijdens het afspelen.

• Controleer of het bestand een VBR-indeling 
(Variable Bit Rate) heeft.

Het product wordt 
warm.

• Er komt tijdens het opladen wat warmte vrij. Dit 
heeft geen invloed op de levensduur of functies 
van het product.

Er wordt een melding 
weergegeven tijdens 
het bekijken van een 
video.

• Probeer de videoclip nogmaals te downloaden 
met EmoDio.
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bijlage
OVERZICHT VAN MENUOPTIES
Hier vindt u een overzicht van de structuur van de menu’s en functies op uw 
nieuwe MP3-speler.

Het selectievenster Menu

Music Videos Pictures Texts  FM Radio Datacasts Prime Pack File Browser Settings

Voice REC Menu Style

Games Sound

Subway Display

Language

Date&Time

System

Sound
Effect

Add
Bookmark Music On Music On

Go to Preset 
Mode /

Go to Manual 
Mode

DNSe Go to 
Bookmark

FM Radio 
On FM Radio On

Add to Preset /
Delete from 

Preset

Play Mode Delete
Bookmark

Start
Slideshow

Go to 1st 
Page Auto Preset

Music Play 
Screen Brightness Zoom Add

Bookmark
Start

Recording

Play
Speed DNSe Rotate Go to 

Bookmark FM Sensitivity

Skip
Interval Auto Pivot Delete

Bookmark FM Region

Repeat
A-B Mode 

On
Transition 

Effect
Text Viewer 

Color

Select as 
My Skin Font Size

View Type

Language
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PRODUCTSPECIFICATIES
Model YP-Q1
Classifi catie DC 5.0V / 500mA
Vermogen ingebouwde batterij 620 mAh / DC 3,7 V
Bestandscompatibiliteit AUDIO: MPEG1/2/2,5 Layer3 (8 kbps ~ 320 kbps, 

22 kHz ~ 48 kHz), WMA (8 kbps ~ 320 
kbps, 8 kHz ~ 48 kHz)

VIDEO: SVI (video: MPEG4, audio: MP3 (44,1 
kHz, 128 Kbps)), WMV (Video: WMV9 
Simple Profi le, Audio: WMA Spec 
(Max 860 kbps), Resolutie: 320 x 240, 
Framesnelheid: 30 fps)

BEELD: JPEG(ISO/IEC 10918-1/Annex F-
Sequential DCT-weergave)

Maximaal aantal 
bestanden/mappen

Mappen: max. 1000 / bestanden: max. 6000 
(incl. mappen)

Uitgangsvermogen oortelefoon 20mW/kan. (Frankrijk 5mW/kan.) (op basis van 16 )
Frequentiebereik 40 Hz - 20 kHz
Signaal/ruisverhouding 90 dB
Afspeelduur Muziek: Max. 30 uur (MP3 128 kbps, Volume: 15, 

Normale geluidsmodus , LCD uit)
Video:  Max. 4 uur (Helderheid 5, Volume: 15, 

normale geluidsmodus)
Temperatuurbereik voor gebruik -5~35°C (23~95°F)
Houder Plastic
Gewicht 65 g
Afmetingen (BxHxD) 51 X 98 X 10,9 mm
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FM Radio FM-frequentie 87,5~108,0MHz Totale harmonische 
vervorming FM 1%

Signaal-
ruisverhouding FM 55 dB Gevoeligheid FM 38dB

De inhoud van deze gebruiksaanwijzing kan ter verbetering zonder 
voorafgaande kennisgeving worden gewijzigd.
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LICENTIE
Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten 
en auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud 
is beperkt tot niet-commercieel gebruik door eindgebruikers. Commercieel 
gebruik hiervan is niet toegestaan. Het gebruiksrecht beperkt zich tot dit 
apparaat en strekt zich niet uit tot andere niet-gelicentieerde onderdelen 
of processen die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3 en die 
in combinatie met dit product gebruikt of verkocht zijn. De licentie beperkt 
zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. 
Deze licentie houdt geen overdracht van rechten in voor producteigenschappen 
of -functies die niet voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

CORRECTE VERWIJDERING VAN DIT PRODUCT 
(ELEKTRISCHE & ELEKTRONISCHE AFVALAPPARATUUR)
Dit merkteken op het product of het bijbehorende informatiemateriaal duidt 
erop dat het niet met ander huishoudelijk afval verwijderd mag worden aan het 
einde van zijn gebruiksduur. Om mogelijke schade aan het 
milieu of de menselijke gezondheid door ongecontroleerde 
afvalverwijdering te voorkomen, moet u dit product van 
andere soorten afval scheiden en op een verantwoorde 
manier recyclen, zodat het duurzame hergebruik van 
materiaalbronnen wordt bevorderd.
Huishoudelijke gebruikers moeten contact opnemen met 
de winkel waar ze dit product hebben gekocht of met de 
gemeente waar ze wonen om te vernemen waar en hoe ze 
dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met 
hun leverancier en de algemene voorwaarden van de 
koopovereenkomsten nalezen. Dit product mag niet worden gemengd met 
ander bedrijfsafval voor verwijdering.
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CORRECTE BEHANDELING VAN EEN GEBRUIKTE 
BATTERIJ UIT DIT PRODUCT
(Van toepassing op de Europese Unie en andere Europese landen met 
afzonderlijke inzamelingssystemen voor accu’s en batterijen.)
Dit merkteken op de batterij, gebruiksaanwijzing of 
verpakking geeft aan dat de batterij in dit product aan 
het einde van de levensduur niet samen met ander 
huishoudelijk afval mag worden weggegooid. De 
chemische symbolen Hg, Cd of Pb geven aan dat het 
kwik-, cadmium- of loodgehalte in de batterij hoger is dan 
de referentieniveaus in de Richtlijn 2006/66/EC. Indien de 
gebruikte batterij niet op de juiste wijze wordt behandeld, 
kunnen deze stoffen schadelijk zijn voor de gezondheid 
van mensen of het milieu.
Ter bescherming van de natuurlijke hulpbronnen en ter bevordering van het 
hergebruik van materialen, verzoeken wij u afgedankte accu’s en batterijen te 
scheiden van andere soorten afval en voor recycling aan te bieden bij het gratis 
inzamelingssysteem voor accu’s en batterijen in uw omgeving.



Wanneer u suggesties of vragen heeft met betrekking tot Samsung producten,
gelieve contact op te nemen met de klantenservice van Samsung

Samsung Electronics Benelux BV
Voor Nederland:

0900-SAMSUNG (726-7864 € 0,10/Min)
www.samsung.com/nl

Voor België: 
02/201 24 18

www.samsung.com/be
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